
312785C
EN

Instructions-Parts

Gateway Network 
Communication Kits

Installation and program setup instructions for use with ProMix® 2KS Electronic 
Proportioners. For professional use only.

Not approved for use in European explosive atmosphere locations.

See page 3 for kit information.

Important Safety Instructions
Read all warnings and instructions in this manual 
and in your proportioning system manual. Save 
these instructions.
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Graco Gateway Kits

15V331 Gateway Ethernet Kit
Allows communication between ProMix 2KS and a PLC 
over an ethernet. Enables process equipment to read 
variables while operating, as well as control the ProMix 
2KS and change setup. It does not provide access to job 
and alarm logs.

15V963 Gateway DeviceNet Kit
Allows communication between ProMix 2KS and a PLC, 
using DeviceNet process control. Enables process 
equipment to read variables while operating, as well as 
control the ProMix 2KS and change setup. It does not 
provide access to job and alarm logs.

15V964 Gateway Profibus Kit
Allows communication between ProMix 2KS and a PLC, 
using Profibus process control. Enables process equip-
ment to read variables while operating, as well as con-
trol the ProMix 2KS and change setup. It does not 
provide access to job and alarm logs.

Related Manuals
Component Manuals in English

Manual Description

312778 ProMix 2KS Automatic System 
Installation

312779 ProMix 2KS Automatic System 
Operation

312780 ProMix 2KS Automatic System 
Repair-Parts

313386 Basic Web Interface/Advanced Web 
Interface
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Warnings
The following warnings are for the setup, use, grounding, maintenance, and repair of this equipment. The exclama-
tion point symbol alerts you to a general warning and the hazard symbols refer to procedure-specific risks. When 
these symbols appear in the body of this manual, refer back to these Warnings. Product-specific hazard symbols and 
warnings not covered in this section may appear throughout the body of this manual where applicable.

WARNING
FIRE AND EXPLOSION HAZARD 
Flammable fumes, such as solvent and paint fumes, in work area can ignite or explode. To help prevent 
fire and explosion:
• Use equipment only in well ventilated area.
• Eliminate all ignition sources; such as pilot lights, cigarettes, portable electric lamps, and plastic drop 

cloths (potential static arc). 
• Keep work area free of debris, including solvent, rags and gasoline.
• Do not plug or unplug power cords, or turn power or light switches on or off when flammable fumes 

are present.
• Ground all equipment in the work area. See Grounding instructions.
• Use only grounded hoses.
• Hold gun firmly to side of grounded pail when triggering into pail.
• If there is static sparking or you feel a shock, stop operation immediately. Do not use equipment 

until you identify and correct the problem.
• Keep a working fire extinguisher in the work area.

ELECTRIC SHOCK HAZARD 
This equipment must be grounded. Improper grounding, setup, or usage of the system can cause 
electric shock.
• Turn off and disconnect power at main switch before disconnecting any cables and before servicing 

equipment.
• Connect only to grounded power source.
• All electrical wiring must be done by a qualified electrician and comply with all local codes and 

regulations.

EQUIPMENT MISUSE HAZARD 
Misuse can cause death or serious injury.
• Do not operate the unit when fatigued or under the influence of drugs or alcohol.
• Do not exceed the maximum working pressure or temperature rating of the lowest rated system 

component. See Technical Data in all equipment manuals.
• Use fluids and solvents that are compatible with equipment wetted parts. See Technical Data in all 

equipment manuals. Read fluid and solvent manufacturer’s warnings. For complete information 
about your material, request MSDS forms from distributor or retailer.

• Check equipment daily. Repair or replace worn or damaged parts immediately with genuine manu-
facturer’s replacement parts only.

• Do not alter or modify equipment.
• Use equipment only for its intended purpose. Call your distributor for information.
• Route hoses and cables away from traffic areas, sharp edges, moving parts, and hot surfaces.
• Do not kink or over bend hoses or use hoses to pull equipment.
• Keep children and animals away from work area.
• Comply with all applicable safety regulations.
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Graco Gateway Overview
The Graco Gateway enables the ProMix 2KS to network 
with a programmable logic controller (PLC). Kits are 
available for Ethernet, DeviceNet, or Profibus protocols. 
The Graco Gateway will support many other protocols; 
contact Graco Technical Assistance for information to 
support your desired protocol.

NOTE: Only persons very familiar with their PLC com-
munication architecture should use this hardware and 
software. This manual assumes that the person using 
the Graco Gateway has full understanding of the PLC 
equipment and related software.

NOTE: Network communications essentially operate 
with the same rules as Discrete I/O. However, network 
communications require placing correct values or 
adjusting appropriate bits within various Modbus regis-
ters (for example, see Table 4). These changes should 
only be made by qualified persons familiar with this type 
of communication.

The module allows for most PLCs to communicate with 
the ProMix 2KS via Modbus RTU protocol by bridging 
the gap between the desired communication protocol 
and RS485 Modbus RTU. As a result, the PLC has full 
access to all the registers for monitoring and controlling 
the ProMix 2KS. It is the responsibility of the integrator 
or user to ensure proper configuration of the communi-
cation hardware on the PLC side.  

Install the Gateway 
Module Hardware

Location

Install the Gateway module near the EasyKey™, in a 
non-hazardous area. 

Mounting
1. See Dimensions, page 79.

2. Ensure that the wall and mounting hardware are 
strong enough to support the weight of the equip-
ment, cables, and stress caused during operation.

3. Using the equipment as a template, mark the 
mounting holes on the wall at a convenient height 
for the operator and so equipment is easily accessi-
ble for maintenance. 

4. Drill mounting holes in the wall. Install anchors as 
needed.

5. Bolt equipment securely.

Grounding

The Gateway module is grounded through its connec-
tion to the EasyKey, which must be connected to a true 
earth ground. See the system installation manual. A 
ground wire and clamp, part no. 223547, is available 
from Graco. 

This equipment is not for use in explosive atmo-
spheres. Do not install equipment approved only for 
non-hazardous location in a hazardous area. 

Your system must be grounded. Read Warnings, 
page 4.
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FIG. 1: Graco Gateway Typical Installation 

TI13939aComputer (PC)
Programmable Logic Controller (PLC)
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Module

EasyKey
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setup only

2-wire twisted 
pair cable, with 
shield wire

PLC Communication
Wire/Cable

(protocol dependent)

NON-HAZARDOUS AREA
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Connect the Module to the 
EasyKey
FIG. 1 is only a guide showing installation of the Graco 
Gateway in a ProMix 2KS System; it is not a complete 
system design, Contact your Graco distributor for assis-
tance in designing a system to suit your particular 
needs.

1. Shut off ProMix 2KS power (0 position). FIG. 2. Also 
shut off power at main circuit breaker.

2. Connect a 2-wire twisted pair cable with shield wire 
from the EasyKey connector to the connector on the 
Gateway module. Connect a communications 
wire/cable (protocol dependent) from the Gateway 
module to the PLC. See FIG. 3.

NOTE: Graco provides expansion cards for DeviceNet 
and Profibus protocols. DeviceNet setup procedures are 
on page 42. Profibus setup procedures are on page 57. 
See page 40 for Parts.

NOTE: If using the Graco Gateway in your system, dis-
connect its cable from the EasyKey before updating the 
ProMix 2KS software.

Cabling Connections
See FIG. 4 and FIG. 5 for typical cable connections in a 
ProMix 2KS system. 

FIG. 6 through FIG. 9 show other possible cable connec-
tions.

FIG. 2: Power Off

0 = OFF

TI12657a
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FIG. 3: EasyKey and Module Cable Connection Points

TI12930a

TI12638a

2-wire twisted pair cable, with
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2-wire twisted pair cable, with 
shield wire (to EasyKey). See 
Wiring Diagrams on page 41 
for pin connections.
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Gateway Module

Communication Wire/Cable (to PLC).
This connection is protocol dependent.

USB Port
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FIG. 4: Graco Gateway Port Pin Outs
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FIG. 6: Programming Ports

TI13969a
Green/Amber LED

RS232/PG

USB/PG

ETHERNET

OR

OR

Yellow LED

FIG. 7: RS232/PG Communication Ports

TI13970a

RS232/PG

OR

FIG. 8: RS232 Communication Ports

TI13971a

RS232

Download from Www.Somanuals.com. All Manuals Search And Download.



Install the Gateway Module Hardware

312785C 11

Mount the Control on DIN Rail
The Gateway control mounts on a DIN rail. Tilt the con-
trol and push down onto the DIN rail, then push in. See 
FIG. 10. A minimum clearance of 1 in. (25 mm) above 
and below the control is required to ensure adequate 
ventilation. 

Install CompactFlash® Card
The CompactFlash socket accepts either Type I or Type 
II cards. These cards are available at most computer 
and office supply retailers. Use cards with a minimum of 
4 Mbytes and a maximum of 2 Gbytes. Use the Com-
pactFlash card for optional database storage only. See 
FIG. 11. 

FIG. 9: Ethernet Connection
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FIG. 11: Install a CompactFlash Card
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Install the GracoConfig Software
GracoConfig software provides access to the Graco 
Gateway module hardware. The CD provided contains 
the GracoConfig software (GracoConfigXXX.exe, where 
the XXX represents the version control number). It also 
includes a preconfigured database which is essentially a 
setup file for the Gateway. The database file has a .gg2 
extension.

The Graco Gateway provides conversions for many pro-
tocols, including the following:

• All Allen-Bradley protocols
• DeviceNet
• Ethernet TCP/IP
• Ethernet IP
• Mitsubishi
• Modbus (ASCII, RTU)
• Profibus
• Siemens

NOTE: Graco provides expansion cards for DeviceNet 
and Profibus protocols. DeviceNet setup procedures are 
on page 42. Profibus setup procedures are on page 57. 
See page 40 for Parts. 

NOTE: Contact your Graco distributor or Graco Techni-
cal Assistance for information regarding additional sup-
ported protocols.

System Requirements
GracoConfig software will run on PCs with the following 
specifications:

• A Pentium class processor as required by the cho-
sen operating system.

NOTE: GracoConfig software will operate with all 

versions of Microsoft® Windows 98 and above. Win-
dows 2000 or above is recommended for more 
robust operation. 

• RAM and free disk space as required by the chosen 
operating system.

• An additional 50MB of disk space for software 
installation.

• A display of at least 800 by 600 pixels, with 256 or 
more colors.

• USB port for downloading a configured database to 
the Gateway module.
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Load the Software
1. Connect the USB cable (23, supplied) between the 

USB port on the Gateway module and a USB port 
on your PC. See FIG. 12.

2. FIG. 13 will appear. Select “Yes, this time only”, then 
click Next.

3. FIG. 14 will appear. Insert the CD in your PC’s 
CDROM drive. Select “Install the software from a list 
or specific location”, then click Next. The program 
location is C:\Program Files\Graco\GracoCon-
fig\Device.

NOTE: The name of the driver may be different. Just 
accept the name and proceed by following the 
instructions on the screen.

Software Updates
Contact your distributor or Graco Technical Assistance 
for software updates.

FIG. 12: Gateway Module USB Port

FIG. 13: Found New Hardware Screen

TI12930a

USB Port

USB Cable Strain Relief

FIG. 14: Load Software from a Specific Location
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Download the Preconfigured 
Database to the Gateway Module
Graco supplies a preconfigured database as a setup file 
for the Gateway, containing parameters which communi-
cate between the Gateway and the ProMix 2KS. The file 
name has a .gg2 extension.

GracoConfig files are downloaded to the Gateway mod-
ule using the Link menu. The programming link between 
the PC and the Gateway module uses the USB cable. 
Before downloading, check that the Communications 
Port is set to USB, as follows.

NOTE: During programming the Gateway module may 
ask for an updated driver. Follow the instructions on the 
screen to automatically find and select the drivers.

1. Go to Start>Programs>Graco>GracoConfig and run 
the program. The GracoConfig main page will 
appear.

2. Using the Link pulldown menu, select Options to 
open the Link Options window. Check that the Com-
munications Port is set to USB, and click OK.

3. Go to File>Open and select the file with the xx.gg2 
extension. The file name should appear at the top of 
the window (FIG. 15) once loaded.

4. Download the database using the Link>Update 

command. As a shortcut, use the Update  

symbol on the toolbar. See FIG. 15.

NOTE: Downloading typically takes only a few sec-
onds but may take longer if the software has to 
update firmware on the Gateway module.

FIG. 15: GracoConfig Main Page

Link Pulldown Menu Update Symbol
FIG. 16: Set Communications Port to USB
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Graco Gateway Network Communications 
Configuration

Startup

To run GracoConfig, select the icon  from the 

Graco folder on the Programs section of your Start 
Menu. The main page will appear, showing the Commu-
nications button.

GracoConfig Main Page

Communications Button

The Communications button provides access to screens 
used to configure your system and setup parameters, 
allowing you to: 

• Specify which protocols are to be used on the Gate-
way serial ports and on the Ethernet port. 

• If using master protocols (ie., protocols by which the 
Gateway initiates data transfer to and from a remote 
device), you can specify one or more devices to be 
accessed. 

• If using slave protocols (i.e., protocols by which the 
Gateway receives and responds to requests from 
remote devices or computer systems), you can set 
read or write access for specific data items. 

• Move data between one remote device and another.

Balloon Help

The Balloon Help feature allows you to see help infor-
mation for each icon in the main menu, or for each field 

in a dialog box or window. It is controlled via the  
icon at the right-hand edge of the toolbar. Balloon Help 
has three user-selectable modes:

• Do Not Display disables balloon help

• When Mouse Over displays help when the mouse 
pointer is held over a particular field for a certain 
period of time

• When Selected displays help constantly for the cur-
rently selected field.

FIG. 17: Communications Button

Communications Button
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Setup the Database
1. Double-click on the Communications button to open 

the preconfigured database (.gg2). The file is 
already setup for ProMix 2KS. See FIG. 18.

2. See FIG. 19. Highlight Protocol 1. Click the Edit but-
ton on the right side of the window to open the 
Driver Picker window. Choose a protocol from the 

lists provided, in this example Modbus and TCP/IP 
Slave. The system will create device PLC1. 

FIG. 18: Preconfigured Database

FIG. 19: Select Protocol
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3. See FIG. 20. Right click on device PLC1 to rename it 
to something meaningful for your system. 

4. See FIG. 21. Add as many Gateway blocks as 
desired under each device. 

FIG. 20: Rename PLC1

FIG. 21: Add Gateway Blocks
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Map Data
1. See FIG. 22. Select the block for data mapping. Click 

the Edit button next to the Start Address field on the 
right side of the window. The Select Address win-
dow will open. 

2. Refer to Table 4 on page 30 for a Modbus map. 
Select the desired Modbus register address as a 
starting point (in this case 40002). Enter the appro-
priate values in the Select Address window and click 
OK. The desired register address will populate the 
Start Address field.

FIG. 22: Mapping Gateway Blocks
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3. See FIG. 23. Click the Edit button next to the Block 
Size field on the right side of the window. The Edit 
Value window will open. Enter the number of Mod-
bus register addresses in the range from the start-
ing address entered in step 2 to the desired ending 
address, inclusive. In this example, 7. The 
addresses must be contiguous. This means that 
each address must be available and addressable 
from the ProMix 2KS. If one of the 7 addresses does 
not exist within the ProMix 2KS Modbus structure, 
the complete block will not communicate.

FIG. 23: Setting Block Size
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4. See FIG. 24. Click OK. The range of addresses will 
appear under the appropriate Block on the left side 
of the window.

NOTE: In this example, a Modbus device master 
communicating via TCP/IP will have direct access to 
Modbus registers 40002 through 40008 of the Pro-
Mix 2KS.
For example, see Block 1 address line 1:

5. The Direction field typically should remain set to 
Device to G3.

Modbus address (command) 
from TCP/IP master 
connected to Gateway.

Modbus address 
of ProMix 2KS.

FIG. 24: Block Mapping Data
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Modbus and I/O Data
See Table 4 through Table 5 for Modbus register 
addresses and input/output data.

Reference the Discrete I/O listing of all the inputs and 
outputs (see page 30). Ensure these are fully under-
stood. The same implementation used for Discrete I/O is 
used for the Network communication protocol. 

For example: The Gun Trigger Input will now be a spe-
cific bit of Modbus Register 40040.  Monitoring of Mod-
bus Register 40041 for specific output status conditions 
will be required as explained in the Discrete I/O section 
of the ProMix 2KS Operation manual. The PLC will have 
to read the various bits, and in some cases (40040 and 
40041 for example) must mask out the various bit posi-
tions to determine each of the separate input and output 
statuses.  This requires experience and should not be 
done on the job site. A full understanding of the color 
change process as well as the required timing of various 
inputs and outputs is required. 

NOTE: Analog input for flow control set point will now be 
a dedicated Modbus register.  Register 40137 will 
require the specific flow rate (i.e. 125 cc/min).  This is 
not a voltage reading but the actual flow target.

Start Mix Process
See FIG. 25, Table 1, and Table 2.

1. Verify that the Mix Ready bit (bit 2 of 40041) is on.

2. Turn on the Mix bit (bit 7 of 40040).

3. Verify that the Mix Active bit (bit 1 of 40041) is on, to 
ensure that the Mix request was received.

Stop Mix Process
See FIG. 26, Table 1, and Table 2.

1. Clear the Mix bit.

2. The Mix Active output should clear and Mix Ready 
should now be set.

NOTE: The ProMix 2KS will automatically go into Idle 
mode after 2 minutes of inactivity. A general alarm will 
be present and Mix Active will remain High. The Alarm 
bit (40010) will indicate the system Idle alarm. When a 
new Gun Trigger input is seen, the ProMix 2KS will 
resume mixing material where it left off. Do not toggle 
the Mix bit; doing so restarts the Mix process from the 
beginning.

Color Change Process
See FIG. 28, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there 
are no alarms and that the system is ready for the 
next command.

2. Load ccNewRecipe (Modbus 40046) with a recipe 
number to color change to.

3. Set color change (40040 bit 6).

4. Verify that Purge_CC_Active is seen (40041 bit 0).

5. Clear color change bit (momentary only).

6. Do not change the ccNewRecipe value until a new 
recipe change is requested.

7. The color change process will stop automatically as 
programmed. Monitor Purge_CC_Active bit for com-
pletion.

Purge Process
See FIG. 27, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there 
are no alarms and that the system is ready for the 
next command.

2. Set purge (40040 bit 8).

3. Verify that Purge_CC_Active is seen (40041 bit 0).

4. When Purge_CC_Active bit clears, clear 
Purge_Start bit. Clearing this bit in the middle of a 
purge sequence will abort the purge sequence.
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FIG. 25. Start Mix Mode Process Flow Chart

Start Mix 
Mode Process

Is Mix Ready 
bit = 1?

Must be Alarm Condi-
tion or Active Recipe 
61. See Alarm Pro-
cessing on page 26, 

or Startup from Recipe 
61 (see NOTE below)

Set Mix bit = 1

Is Mix Active 
bit = 1?

ProMix 2KS in Mix 
Mode (Complete) 

Mix Active = 1 while 
the ProMix 2KS is in 

Mix mode

YESNO

NO

YESNOTE: At power up the system 
defaults to Recipe 61, which is 
not a valid recipe number. Initiate 
a color change to Recipe 0 or a 
valid recipe number (1-60).
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FIG. 26. Mixing Mode Process Flow Chart

Mixing Mode 
Process

Is Mix Active 
bit = 1?

Check Alarm
Condition: is Alarm_

General bit = 1?

YESNO

NO

YES

Mixing Mode is desired. 
PLC is polling to ensure 
Mixing Mode is main-

tained.

Mixing Process active

2KS is in Standby. Go to 
Start Mix Process, page 

21.

Go to Alarm Process-
ing, page 26
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FIG. 27. Purge Mode Process Flow Chart

Start

Is Mix Ready 
bit = 1?

Must be Alarm
Condition or Active 

Recipe 61. See 
Alarm Processing 

on page 26, or 
Startup from Recipe 

61 (see NOTE below).

YESNO

NO

YES

ProMix 2KS in 
Purge_CC Mode 
(Process Started)

Set Purge bit = 1?

Is Purge_CC_Active 
bit = 1?

Is Mix Ready 
bit = 1?

NO

YES

(Wait for Mix Ready)

Set Purge Bit = 0.
ProMix 2KS Purge 

Process (Complete)
NOTE: At power up the system 
defaults to Recipe 61, which is 
not a valid recipe number. Initiate 
a color change to Recipe 0 or a 
valid recipe number (1-60).
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FIG. 28. Color Change Mode Process Flow Chart

Process Alarm. See 
Alarm Processing, 

page 26.

Color Change 
Process 
(basic)

Is 
Purge_CC_Active 

bit = 1?

Check Alarm
Condition: is Alarm_

General bit = 1?

YES NO

NO

YES

Is Active Recipe = 
to desired recipe? 
(Register 40005).

Clear ColorChange (CC) 
bit (momentary input). 
CC process started.

Load ccNewRecipe 
(Register 40046) with 

recipe number to Color 
Change to (0 through 

60 is valid).

Do nothing. 
Spraying at 

desired recipe.

NO

YES

Set ColorChange (CC) 
bit = 1.

ProMix 2KS Color 
Change Process 

(Complete)

Is Mix Ready 
bit = 1?

(Wait for Mix Ready)

YES
NO

Ensure Color-
Change bit is seen 

by ProMix 2KS
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Alarm Processing

See FIG. 29, Table 1, Table 2, and Table 3.

FIG. 29. Alarm Processing Flow Chart

Alarm Processing

Is Mix Ready 
bit = 1?

Check if Potlife 
Alarm: is Alarm_
Potlife bit = 1?

YESNO

NO YES

An Alarm Condition
has been found

previously. 
Alarm_General = 1.

Two options:

• Purge or Color Change to remove 
mixed material in the line.

• Place in Mix mode and spray the 
Potlife Volume set in the ProMix 
2KS.

NOTE: The Reset key only silences 
the alarm. To clear the alarm you must 
use one of these two options.

Go to next process, 
as desired.

Determine the exact alarm 
from Table 3 on page 29 

and solve what caused the 
alarm, as required.

Reset the alarm. 
Reset_Alarm = 1.
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NOTE: Shaded cells relate to the flow charts on pages 23-26.

Table 1: ProMix 2KS Digital Inputs (Modbus Register 40040)

Bit Digital Input Binary Name Details

0:5 0 0 0 0 0 0 0 0 0 0 X X X X X X Recipe Binary bits for viewing discrete inputs only.

6 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 Color Change 
(CC)

Set bit to “1” to initiate Color Change (momentary)

7 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 Mix Set bit initiate Mix mode (maintain)

8 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 Purge Set bit to “1” to initiate Purge sequence (maintained)

9 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 Job_Complete Set bit to “1” to initiate Job Complete input (momen-
tary)

10 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 External CC 
Ready

Set bit to “1” to initiate External Color Change 
(momentary)

11 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 Not Used

12 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 FC _Calibrate Set bit to “1” to initiate a Flow Control Calibrate input 
(momentary)

13 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 Gun_Trigger Set bit to “1” to indicate the gun is actually triggered 
(maintain while gun is triggered, remove when gun is 
closed)

14 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 Reset_Alarm Set bit to “1” to clear an active Alarm (momentary)

15 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 Remote Stop Set bit to remotely stop unit (momentary)
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NOTE: Shaded cells relate to the flow charts on pages 23-26.

Table 2: ProMix 2KS Digital Outputs (Modbus Register 40041)

Bit Digital Input Binary Name Details

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 Purge_CC_Active “1” indicates Purge or Color Change is in prog-
ress

1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 Mix_Active “1” indicates Mix is in progress

2 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 Mix_Ready “1” indicates No Alarms and OK to Mix

3 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 CC_Fill_Active “1” indicates the Fill portion of a Color Change is 
in progress

4 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 FCalActive “1” indicates the Flow Control Calibrate routine is 
in progress

5 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 Flow_Rate_Alarm “1” indicates the Flow Rate Alarm/Warning is 
active

6 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 Special_1 “1” indicates the Special_1 output is on (monitor 
only)

7 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 Special_2 “1” indicates the Special_2 output is on (monitor 
only)

8 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 Special_3 “1” indicates the Special_3 output is on (monitor 
only)

9 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 Special_4 “1” indicates the Special_4 output is on (monitor 
only)

10 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 Not Used

11 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 Not Used

12 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 Alarm_General “1” indicates a General Alarm is in process. (If 
Mix_Active is still High, then a Warning only.) See 
ProMix 2KS Active Alarms (Modbus Register 
40010) on page 29 for details on type.

13 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 Alarm_Potlife “1” indicates a Potlife Alarm is in process.
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ProMix 2KS Active Alarms (Modbus Register 40010)
Table 3: ProMix 2KS Active Alarms (Modbus Register 40010)

Bit Digital Input Binary Name Details

Low Byte: 0 0000 0000 0000 0000 No Bits Set No Active Alarms

Low Byte: 0 0000 0000 0000 0001 Comm_Error

Low Byte: 0 0000 0000 0000 0010 Potlife_Alarm

Low Byte: 0 0000 0000 0000 0100 Ratio_High_Alarm

Low Byte: 0 0000 0000 0000 1000 Ratio_Low_Alarm

Low Byte: 0 0000 0000 0001 0000 Overdose_A_Alarm

Low Byte: 0 0000 0000 0010 0000 Overdose_B_Alarm

Low Byte: 0 0000 0000 0100 0000 Dose_Time_A_Alarm

Low Byte: 0 0000 0000 1000 0000 Dose_Time_B_Alarm

Low Byte: 0 0000 0001 0000 0000 Mix_In_Setup_Alarm

Low Byte: 0 0000 0010 0000 0000 Remote_Stop_Alarm

Low Byte: 0 0000 0100 0000 0000 Purge_Volume_Alarm

Low Byte: 0 0000 1000 0000 0000 CC_Comm_Error_Alarm

Low Byte: 0 0001 0000 0000 0000 High_Flow_Alarm

Low Byte: 0 0010 0000 0000 0000 Low_Flow_Alarm

Low Byte: 0 0100 0000 0000 0000 System_Idle_Alarm

Low Byte: 0 1000 0000 0000 0000 Setup_Change_Alarm

High Byte: 0 0000 0000 0000 0001 Power_On_Alarm

High Byte: 0 0000 0000 0000 0010 Defaults_Loaded_Alarm

High Byte: 0 0000 0000 0000 0100 IO_Alarm

High Byte: 0 0000 0000 0000 1000 Purge_Initiate_Error

High Byte: 0 0000 0000 0001 0000 Material_Fill_Alarm

High Byte: 0 0000 0000 0010 0000 Tank_A_Low_Alarm

High Byte: 0 0000 0000 0100 0000 Tank_B_Low_Alarm

High Byte: 0 0000 0000 1000 0000 Tank_S_Low_Alarm

High Byte: 0 0000 0001 0000 0000 Auto_Dump_Complete

High Byte: 0 0000 0010 0000 0000 Color/Catalyst_Purge_Alarm

High Byte: 0 0000 0100 0000 0000 Color/Catalyst_Fill_Alarm

High Byte: 0 0000 1000 0000 0000 Num_Alarm_Desc

High Byte: 0 0001 0000 0000 0000 Spare3_Alarm

High Byte: 0 0010 0000 0000 0000 Spare2_Alarm

High Byte: 0 0100 0000 0000 0000 Spare1_Alarm

High Byte: 0 1000 0000 0000 0000 Potlife_Buzzer

Download from Www.Somanuals.com. All Manuals Search And Download.



Modbus and I/O Data 

30 312785C

ProMix 2KS Modbus/TCP Variable Map

* This column represents the rule that must be implemented by automation. Writing to Read Only registers must be 
avoided.

** For ProMix 3KS Systems only.

Table 4: ProMix 2KS Modbus/TCP Variable Map

* Read/Write 
Status

EasyKey 
Modbus 
Register Description Size Units Low Limit High Limit

Read Only 40003 Current flow rate 16 Bit cc/min 0 5000
Read Only 40004 Actual ratio 16 Bit none 0 9999
Read Only 40005 Active recipe 16 Bit none 0 60
Read Only 40006 Potlife 1 remaining 16 Bit sec 0 9999
Read/Write 40007 Job complete 16 Bit none 0 0xFFFF
Read/Write 40008 Reset job total 16 Bit none 0 9
Read Only 40009 Potlife 2 remaining 16 Bit sec 0 9999
Read Only 40010 Active fault 32 Bit none 0 0xffffffff
Read Only 40032 Control version 32 Bit none 0 0xffffffff
Read/Write 40040 Robot digital input 16 Bit none 0x0000 0xFFFF
Read Only 40041 Robot digital output 16 Bit none 0x0000 0xFFFF
Read/Write 40046 New recipe 16 Bit none 0 60
Read Only 40048 Current fluid pressure 16 Bit psi 0 5000
Read Only 40049 V/P percent output 16 Bit % 0 100
Read Only **40056 Actual ratio reducer 16 Bit none 0 9999
Read Only 40114 Flow control option 16 Bit 0=proportioning only

1=1K flow control 
(future)

2=2K flow control
3=pressure override
4=manual percent 

override

0 4

Read/Write 40115 Flow setpoint data source 16 Bit 0=discrete
1=network

0 1

Read/Write 40120 Manual override percent 
opening

16 Bit % 0 100

Read/Write 40125 Flow control range 16 Bit 0=0-300 cc/min
1=0-600 cc/min
2=0-1200 cc/min

0 2

Read/Write 40126 Flow control tolerance 16 Bit % 0 99
Read/Write 40127 Flow control proportional 

gain Kp
16 Bit default=400 0 9999

Read/Write 40128 Flow control integral gain 
Ki

16 Bit default=40 0 9999

Read/Write 40129 Flow control alarm time 16 Bit sec 0 99
Read/Write 40137 Flow control setpoint 16 Bit cc/min 0 1200
Read/Write 43123 Flow control override 

mode
16 Bit 0=off (normal)

1=% open
2=pressure mode

0 2

Read/Write 43141 Flow control enable 16 Bit 0=off
1=on

0 1
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ProMix 2KS Recipe Bits
Table 5: ProMix 2KS Recipe Bits

Recipe Bits Number Recipe Bits Number

5 4 3 2 1 0 5 4 3 2 1 0
0 0 0 0 0 0 0 1 0 0 0 0 1 33

0 0 0 0 0 1 1 1 0 0 0 1 0 34
0 0 0 0 1 0 2 1 0 0 0 1 1 35

0 0 0 0 1 1 3 1 0 0 1 0 0 36
0 0 0 1 0 0 4 1 0 0 1 0 1 37

0 0 0 1 0 1 5 1 0 0 1 1 0 38
0 0 0 1 1 0 6 1 0 0 1 1 1 39

0 0 0 1 1 1 7 1 0 1 0 0 0 40
0 0 1 0 0 0 8 1 0 1 0 0 1 41

0 0 1 0 0 1 9 1 0 1 0 1 0 42
0 0 1 0 1 0 10 1 0 1 0 1 1 43

0 0 1 0 1 1 11 1 0 1 1 0 0 44
0 0 1 1 0 0 12 1 0 1 1 0 1 45

0 0 1 1 0 1 13 1 0 1 1 1 0 46
0 0 1 1 1 0 14 1 0 1 1 1 1 47

0 0 1 1 1 1 15 1 1 0 0 0 0 48
0 1 0 0 0 0 16 1 1 0 0 0 1 49

0 1 0 0 0 1 17 1 1 0 0 1 0 50
0 1 0 0 1 0 18 1 1 0 0 1 1 51

0 1 0 0 1 1 19 1 1 0 1 0 0 52
0 1 0 1 0 0 20 1 1 0 1 0 1 53

0 1 0 1 0 1 21 1 1 0 1 1 0 54
0 1 0 1 1 0 22 1 1 0 1 1 1 55

0 1 0 1 1 1 23 1 1 1 0 0 0 56
0 1 1 0 0 0 24 1 1 1 0 0 1 57

0 1 1 0 0 1 25 1 1 1 0 1 0 58
0 1 1 0 1 0 26 1 1 1 0 1 1 59

0 1 1 0 1 1 27 1 1 1 1 0 0 60
0 1 1 1 0 0 28

0 1 1 1 0 1 29
0 1 1 1 1 0 30

0 1 1 1 1 1 31
1 0 0 0 0 0 32
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Troubleshooting 
NOTE: This section covers the most common problems 
encountered while setting up, programming or using the 
product. Do not forget to always download in the device 
after changing settings in Graco Gateway.

General Troubleshooting

PROBLEM CAUSE SOLUTION

Unit screen is blank and PWR LED is 
off. 

No power applied to the unit. Check power supply. Units require 24 
VDC, ± 10%.

Unit screen is blank and PWR LED is 
on.

Contrast too low (Graco Gateway 
only). 

Program one of the soft keys with the 
action as User Defined and the fol-
lowing code in the field On Pressed: 
dispcontrast++

No primitives on the display. Add objects to the User Interface in 
Graco Gateway.

Backlight is off. Push one of the soft keys to turn it 
back on.

Backlight tube is broken. Replace the backlight tube.

Unit continually cycles on and off. Cross-references between tags, e.g., 
Var1 uses Var2 as maximum which in 
turn uses Var1 as minimum.

Remove one of the references or use 
formula tags for indirect reference, 
e.g., Form1 is equal to Var1 and used 
in Var2 minimum instead of Var1.

Database is corrupted. Create a new database or send to 
technical support for debugging.

Unit cycles power after an operation. Most likely a program going in an 
endless loop.

Check if the operation launches pro-
gram containing loops with no exit 
point.

CF LED flashing slowly. CF card corrupted or invalid. Format the card from Graco Gateway 
using the Link > Format Flash menu.
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Unit shows “Version Mismatch”. The database currently in the device 
does not match Graco Gateway’s 
firmware version. (Message occurs 
after a download with a new version 
of C2 interrupted before the database 
was downloaded.)

Download the database from Graco 
Gateway again.

Unit shows “Invalid Database”. The database in the device is cor-
rupted or there are no databases in 
the device.

Download a database from Graco 
Gateway.

Values show “----” No communication with target device. See Serial Communication Trou-
bleshooting (page 36) or Ethernet 
Communication Troubleshooting 
(page 37).

Value does not update. The tag on the screen is not linked 
correctly.

Check the tag mapping making sure 
the target device (PLC, etc.) register 
is correct.

Check the primitive Data Source in 
the user interface in case the word 
WAS is displayed. Re-link the tag in 
this case.

Value shows +BIG or –BIG. Not enough digits before the decimal 
point to show the number. For exam-
ple, data is 1000.5 and format is 
three digits before the decimal point 
and one after.

Increase the number of digits before 
the decimal point in the tag format.

Value deviates by a factor of ten. The tag format is not correct. Change the decimal point position in 
the tag format.

Value is invalid. Incorrect tag type. Check if the tag type corresponds to 
the data type. Is the data a floating 
point number and thus the tag a real 
(Pi symbol), and not an integer (X 
symbol)?

Incorrect data mapping. Check if the tag is accessing the cor-
rect target device register.

Incorrect primitive on the display. Check if the primitive corresponds to 
the tag type. For example, primitive is 
a Text Integer so the tag has to be an 
integer.

Data received is not what’s expected. 
For example, bytes reversed in the 
word.

Use the transform property on the tag 
to modify the data source. You might 
have to try multiple solutions to solve 
the issue.

PROBLEM CAUSE SOLUTION
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Symbol or image leaves a trace when 
animated.

The background of the image is not 
refreshed.

Change the primitive Fill Format to 
Solid color.

Add the system variable dispcount 
in the background of the image to 
force the refresh.

Rich Bar Graph or Dial Gauge does 
not move

Tag minimum and maximum are not 
setup.

Check the tag’s minimum and maxi-
mum values. These are used by both 
primitives for minimum and maxi-
mum.

Trend Viewer curve stuck at the bot-
tom.

No minimum and maximum setup on 
the data tags displayed in the viewer.

Check that all displayed tags in the 
trend viewer have a Minimum and a 
Maximum setup.

USB Drivers location for Windows. Location of the drivers unknown. The drivers are located under Graco 
Gateway 2.0\Device installation 
folder. For example C:\Program 
Files\Graco Gateway\Device.

USB Driver installation. The operating system is unable to 
find the driver or the installation 
failed.

In your operating system device man-
ager, check if the Graco Gateway is 
present. If so, uninstall that device. 
Follow the USB installation guide.

Upgrading Graco Gateway did not 
upgrade the software version.

The option selected during the 
upgrade was Modify instead of 
Repair.

Launch the upgrade again and 
choose Repair when prompted.

PROBLEM CAUSE SOLUTION
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Graco Gateway Messages Troubleshooting 

PROBLEM CAUSE SOLUTION

Device incompatible with file. The device you are trying to down-
load into doesn’t match the database 
device.

Create a new database file corre-
sponding to your device (File > New).

Unable to open communication port. The communication port you try to 
download with is unavailable:

• Cable not connected. Check if the cable is connected cor-
rectly to the PC and the device pro-
gramming ports (USB or PG Port).

• Incorrect download communica-
tion port.

Check that Graco Gateway is 
directed to the correct communica-
tion port (Link > Options).

• Port already used. Check that the communication port is 
not used by another service or soft-
ware especially for serial ports.

• Target device IP address incor-
rect.

If you download via Ethernet, check 
the IP address of the target device in 
Link > Options.

• No USB Drivers. Check that the USB drivers were 
installed successfully. Reinstall 
Graco Gateway USB driver under the 
PC device manager if necessary.

No reply from terminal. Cable is not connected. Make sure the cable is connected or 
check above solutions.

If the message appears while down-
loading to the device.

Download again with Link > Update 
or F9.

CompactFlash required for upgrade. The version of Graco Gateway on the 
PC is different from the target device 
firmware version when attempting a 
download via Ethernet.

Insert a CompactFlash Card in the 
target device.

Use another communication port for 
download: USB or Serial.

The window is too small to allow edit-
ing.

The current User interface view is too 
small to allow editing.

Change the panel view using View > 
Panel > Display only.

The device returned an unexpected 
reply code.

The device you are trying to down-
load to is not supported by this ver-
sion of Graco Gateway.

Update Graco Gateway to the latest 
version available (contact your Graco 
distributor or Graco Technical Assis-
tance). Choose Repair when upgrad-
ing.
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Serial Communication Troubleshooting

This section is used to troubleshoot the communication between two devices linked via serial ports, i.e. RS232 or 
RS485.

TIP: For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including 
only one data tag mapped to a known register in the target device.

PROBLEM CAUSE SOLUTION

Values show “----” Port settings do not match. Check that the port settings of the 
Graco Gateway device match the tar-
get device (i.e. Baud, Parity, etc.).

Incorrect target device address. Check that the target device address 
in Graco Gateway (in communica-
tions on the PLC symbol) matches 
the target device address setup.

Incorrect cable. Check the cable part number or 
cabling to match your protocol.

Incorrect communication port. Check if the cable is connected to the 
correct communication port.

If the above is correct, check that the 
protocol settings are on the correct 
communication port in Graco Gate-
way.

Communication port connector pins 
bent inward.

Although unlikely, check the commu-
nication port connector pins on the 
Graco Gateway in case some are 
bent inward resulting in a bad contact 
with the cable.

Incorrect tag mapping. Check that the tag is mapped to an 
existing register in the target device.

Values blink between the data and 
“----”

Incorrect tag mapping on one of the 
tags on the display.

Delete tags one after another and 
download in-between. When the val-
ues on the screen stop blinking, the 
last deleted tag was mapped incor-
rectly or accessed an unknown regis-
ter in the target device.

Communications times-out. Increase the Slave Response or 
Device Timeout on the communica-
tion port or target device in Graco 
Gateway.
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Ethernet Communication Troubleshooting 

This section is used to troubleshoot the communication between two devices linked via Ethernet.

TIP: For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including 
only one data tag mapped to a known register in the target device.

PROBLEM CAUSE SOLUTION

Values show “----” Incorrect target device IP address. Check the target device IP address in 
Graco Gateway (in communications 
on the PLC symbol) to match the tar-
get device IP address setup.

Incorrect cable or wrong connection. Check the LED on the Graco Gate-
way device Ethernet port. If none are 
lit, there are no connections. Check 
the cable or that the Ethernet port is 
enabled in Graco Gateway, see 
below.

Ethernet port disabled. Check that the Ethernet port in Graco 
Gateway is enabled.

Graco Gateway and target devices 
are in a different address domain:

• If no routers are present on the 
network.

Check that the target device IP 
address and Graco Gateway device 
IP address are different but in the 
same domain. (For example, both 
start with the same three first num-
bers; ex: 192.168.2.xxx if the mask is 
255.255.255.0).

• If a router is present on the net-
work.

Check the Graco Gateway device 
Ethernet port Gateway address to 
match the router IP address.

Incorrect tag mapping. Check that the tag is mapped to an 
existing register in the target device.

Values blink between the data and 
“----”

Incorrect tag mapping on one of the 
tags on the display.

Delete tags one after another and 
download in-between. When the val-
ues on the screen stop blinking, the 
last deleted tag was mapped incor-
rectly or accessed an unknown regis-
ter in the target device.

Communications times-out. Increase the Slave Response or 
Device Timeout on the communica-
tion port or target device in Graco 
Gateway.
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LED Functions

Status (STS) LED

The green Status LED provides information on the sta-
tus of the Graco Gateway, including various stages of 
the startup routine and any errors that occur.

User Communication Ports - TX/RX LEDs

Ethernet LEDs

CompactFlash (CF) LED

* Do not turn off power to the unit while this light is 
flickering. The unit writes data in two minute inter-
vals. Later Microsoft operating systems will not lock 
the drive unless they need to writer data; Windows 
98 may lock the drive any time it is mounted, thereby 
interfering with logging. Contact Graco Technical 
Assistance for further information.

Status Indication

Rapidly 
Flashing

Graco Gateway is currently running the 
boot loader and/or being upgraded.

Steady Graco Gateway is operating normally.

Status Indication

Green Transmitting
Red Receiving

Status Indication

Yellow 
(Steady)

Link Established

Yellow 
(Flashing)

Network Activity

Green 10 BASE-T Communications
Amber 10 BASE-TX Communications

Status Indication

Off No CompactFlash card is present.
Steady Valid CompactFlash card is present.
Rapidly 
Flashing

CompactFlash card is being checked.

Flickering Unit is writing to the CompactFlash 
card, either to store data or because the 
PC connected via the USB port has 
locked the drive.*

Slowly 
Flashing

Incorrectly formatted CompactFlash 
card is present.
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System Electrical Schematic
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Parts

15V331 Gateway Ethernet Kit (shown)

15V963 Gateway DeviceNet Kit

15V964 Gateway Profibus Kit

▲ Replacement Danger and Warning labels, tags, and 
cards are available at no cost.

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective 
owners.

Ref. 
No. Part No. Description Qty

1 15V339 PANEL, back 1
2 15T752 COVER 1
3 n/a DIN RAIL 1
4 120369 POWER SUPPLY, 24 Vdc 1
5 15V345 GROMMET, cable entry 2
6 111987 CONNECTOR, strain relief 1
7 n/a WIREWAY 1
8▲ 186620 LABEL, ground 1
9 n/a COVER, wireway 1
10 CONTROL BOX, Gateway
10a 15V966 BOX, DeviceNet; includes 

items 20a, 23, and 27; used 
on 15V963 Kit only

1

10b 15V965 BOX, Profibus; includes items 
20b, 23, and 27; used on 
15V964 Kit only

1

10c 15X492 BOX, ethernet; includes items 
23 and 27; used on 15V331 
Kit only

1

11 120838 BLOCK, clamp end 2
12 103833 SCREW, machine 4
13 112443 BLOCK, terminal, ground 1
14 15V344 CONNECTOR 1
15 121994 CABLE, CAT 5 1
16 121700 CABLE, 2 connector 1
17 n/a WIRE, copper, 16 ga.; 9 in. 

(230 mm)
1

18 n/a WIRE, copper, 16 ga; 9 in. 
(230 mm)

1

20a 15V347 CARD, DeviceNet; 15V963 Kit 
only

1

20b 15V346 CARD, Profibus; 15V964 Kit 
only

1

23 15T999 CABLE, USB; not shown 1
25 n/a SCREW, machine, serrated 

hex-head
4

27 258527 CD ROM, software, Gateway; 
not shown

1

Ref. 
No. Part No. Description Qty
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TI12930a

TI12932a

TI12929a

3

4

5 6

8

10

11

12

1314

15

17
14

18

18

17

14

7, 9, 121, 2

To 4 To 10

Wiring Diagrams

TI12931a

1 2 3 4 5 6 7 8 shsh

1 2 3
A SHB

ProMix 2KS EasyKey 
RS485 Network Terminals

DRRJ45 Network Terminals

16

410a, b, or c 20a or b

USB Port
(ref item 23)

Screw Location
(item 25)
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Appendix A: DeviceNet™ Slave Communication

Overview
This appendix describes the Gateway’s support for Devi-
ceNet and details the configuration steps necessary to 
use this feature. It does not provide a detailed descrip-
tion of DeviceNet, but only a brief introduction, neces-
sary to define the terms that are used throughout the 
remainder of this document.

Introduction
DeviceNet is a low-level network using the Controller 
Area Network (CAN) technology, to provide communica-
tion between a range of industrial devices, from simple 
devices such as sensors and actuators, to high-level 
devices such as controllers and HMIs.

DeviceNet Port Protocols
The DeviceNet option card has one DeviceNet port. See 
FIG. 30. The port may be configured for various Devi-
ceNet protocols. Contact Graco Technical Assistance for 
currently supported protocols.

Also see Appendix A: DeviceNet™ Slave Communi-
cation on page 42.

DeviceNet Option Card Pin Outs

• V-
Position 1 of the pluggable connector provides a 
CAN ground connection. This terminal is isolated 
from the Graco Gateway.

• CAN_L
Position 2 of the pluggable connector provides the 
CAN_L bus line (active low). This terminal is iso-
lated from the Graco Gateway.

• DRAIN (optional)
Position 3 of the pluggable connector is provided for 
optional drain connections. This position is available 
only to tie drain wires together or to earth ground. 
There is no internal connection to earth ground. The 
DRAIN position is not connected to any circuitry 
internal to the DeviceNet option card.

• CAN_H
Position 4 of the pluggable connector provides the 
CAN_H bus line (active high). This terminal is iso-
lated from the Graco Gateway.

• V+ (optional 24 Vdc)
Position 5 of the pluggable connector is provided for 
optional 24 Vdc connections. This position is avail-
able only to tie 24 Vdc wires together. The Devi-
ceNet option card neither provides or uses 24 Vdc 
power through this connection. The V+ position is 
not connected to any circuitry internal to the Devi-
ceNet option card or Graco Gateway.
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FIG. 30: DeviceNet Port Pin Outs and PLC Connection
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About DeviceNet
DeviceNet is a connection-based network. In this con-
text the term connection refers to a communication path 
between two or more devices, and not the physical 
(cable) connection to the DeviceNet network. A connec-
tion must be established between two devices in order 
to transfer data.

There are two types of connection defined by the Devi-
ceNet specification. Each has different characteristics 
and is suited to a specific type of communication.

• I/O Connection – Dedicated data transfer between 
a producer and one or more consumers. The format 
of the data is known or implied by the connection.

• Explicit Messaging – Generic multi-purpose mes-
saging connection, typically command and 
response message commands.

Each connection type has an extensive number of 
parameters, which can affect the characteristics of the 
communication path. For many Master/Slave communi-
cations scenarios, a defined set of connections, together 
with their respective parameter settings exist under the 
collective name Predefined Master/Slave Connection 
Set. Many of the steps involved in creating and configur-
ing a connection have been removed with this connec-
tion set, thus simplifying the network configuration.

Predefined Master/Slave Connection Set

The DeviceNet specification details a number of con-
nections that facilitate data transfer between a Master 
and Slave devices. The following sections detail the con-
nection types supported by the Gateway.

• I/O Bit-Strobe Connection: The Bit-Strobe connec-
tion is an I/O connection over which Bit-Strobe I/O 
command and response messages are transferred. 
The Bit-Strobe command is broadcast by the Master 
device and is received by all slave devices simulta-
neously. The command message contains a single 
bit of information for each slave on the network. 
Each slave device is required to respond with a Bit- 
Strobe response message. The response message 
can contain up to 8 bytes of information.

• I/O Poll Connection: The Poll connection is an I/O 
connection over which Poll command and response 
messages are transferred. The Poll command is 
transmitted by the master, and is directed to a single 
slave device. The slave device in turn responds with 
a Poll response message. Both the Poll command 
and Poll response messages can contain any num-
ber of bytes.

• I/O Data Connection: The I/O Data connection is 
part of the Predefined Master/Slave Connection Set, 
but instead is included for devices, which support 
creating I/O data connections via the UCMM 
(Unconnected Message Manager).

Level of Support

The Gateway provides Group 2 Server level support: A 
UCMM capable device that is configured to act as a 
Slave for the Predefined Master/Slave connection set.
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Hardware
To use DeviceNet on the Gateway, an option card must 
first be installed. The option card provides the hardware 
necessary to support the CAN physical layer specifica-
tion as required by the DeviceNet standard.

Configuring the option card is a two-stage process; first 
the option card must be selected in Gateway (DeviceNet 
Option Card), and then the ‘DeviceNet Predefined 
Group 2 Server Driver’ configured to run on the newly 
created DeviceNet Interface port.

Gateway Configuration

The following example requires use of an Allen Bradley 
1756-ControlLogix PLC, along with RSLogix 5000 and 
RSNetWorx for DeviceNet software and a Gateway.

Configure the Gateway DeviceNet Option 
Card

Install the Gateway DN0000 option card in the Gateway 
as per the provided instructions.

Click on File>New to create a new Gateway database 
and select Gateway Series HMI – Gateway 10.

Enter the Communications section. In the tree on the 
left, select Gateway from the top of the tree. Select the 
Edit button at the right, and select the DeviceNet Option 
Card from the dialog box as shown in FIG. 31. Click OK.

FIG. 31: Select DeviceNet Option Card
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The DeviceNet Option card appears at the end of the 
tree. Select the DeviceNet Interface from under the 
DeviceNet Option Card item.

On the right hand pane, click on the Edit button to open 
the driver picker dialog box. Select the DeviceNet Pre-
defined Group 2 Server driver. FIG. 32.

Set the appropriate Station Address, Baud Rate, and I/O 
Poll Size. Make sure the Data Format Settings are set to 
Transform: Swap Bytes In Word. FIG. 33.

FIG. 32: Select DeviceNet Server
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IMPORTANT NOTE: The I/O Polled Size is determined 
by the settings in both the DeviceNet Master and the 
registered .EDS file for the Gateway. To change these 
settings, see Automatic Update of the EDS File on 
page 51 before setting up the PLC.

FIG. 33: Device Settings
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Create Gateway Blocks

Select the DeviceNet device from the tree at the left, and 
add two Gateway Blocks; one for Read Data and one for 
Write Data, using the Add Gateway Block button on the 
right hand pane.

Select the first Gateway Block and select the Edit button 
at the right.

Set the block for I/O Polled Command Data, starting at 
element PollC 00000. FIG. 35.

FIG. 34: Add a Gateway Block
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NOTE: For 16-bit support, select Word as Word. For 
32-bit support, select Word as Long. The latter is recom-
mended as DeviceNet uses 32 bits integer addressing.

Set the block size for 4, and the Direction for: Device To 
Gateway. This will be the Read Data block.

FIG. 35: Select Data Type (Word as Long)
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Select the second Gateway Block and set it up for I/O 
Polled Response Data 00000, with a length of 4, and the 
Direction Gateway To Device. This will be the Write Data 
Block. FIG. 36 shows both Gateway blocks once com-
pleted.

NOTE: Read and Write are from the Gateway point of 
view. This means the master can send data in Block A, 
so the Gateway can read data. On the other hand, the 
master can only pull data from Block B, so the Gateway 
can only write data.

The addressing scheme available is outlined below:

BitC – Identifies the I/O Bit-Strobe command data (Mas-
ter to Slave).

BitR – Identifies the I/O Bit-Strobe response data (Slave 
to Master).

PollC – Identifies the I/O Poll command data (Master to 
Slave).

PollR – Identifies the I/O Poll response data (Slave to 
Master).

DataC – Identifies the I/O Consumed Data (Master to 
Slave).

DataP – Identifies the I/O Produced Data (Slave to Mas-
ter).

FIG. 36: DeviceNet Block Mapping
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Automatic Update of the EDS File
DeviceNet nodes use an EDS (Electronic Data Sheet) to 
describe the communications parameters available at 
each device on the DeviceNet network.

By design, each DeviceNet master can handle a maxi-
mum of 124 Input words and 123 Output words. In the 
default EDS file for the Gateway, the Input and Output 
data sizes are set at 16 bytes each. This equates to four 
words of data input and four words of data output. These 
values can be set higher, but it is important to note that if 
the default values are set higher, they might conflict with 
other DeviceNet implementations.

Gateway provides an EDS file generator tool to create a 
file that matches your Gateway settings. This file can 
therefore be used to configure the Master.

To generate this file, enter the Communications module 
and select the DeviceNet interface on the left. Under the 
Electronic Data Sheet, select Yes in Synchronize and 
choose the path and name where the file should be 
saved using the Browse button. FIG. 37.

Saving the database using the File>Save command will 
synchronize and therefore update the EDS file.

Each time EDS parameters are modified, the EDS file 
will need to be re-registered within RSNetWorx for Devi-
ceNet. These changes will also need to be reflected in 
the following locations:

• RSNetWorx master node Scanlist, Input Table, and 
Output Table

• ControlLogix PLC DeviceNet Scanner configuration

NOTE: Inputs and Outputs are with respect to the mas-
ter, therefore inputs refer to data sent from the slave and 
read by the master.

FIG. 37: Automatic EDS Update
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Configure the RSNetWorx for DeviceNet Software
RSNetWorx for DeviceNet is used to set up and manage 
a DeviceNet network. To begin the configuration, launch 
RSNetWorx for DeviceNet from your development PC.

Start a new network by selecting: File>New>DeviceNet 
Configuration.

Register the EDS file generated by Gateway as shown 
in the previous section of this document by selecting: 
Tools>EDS Wizard>Register an EDS file(s).

Select Register a single file, and browse to the location 
where you saved the Gateway.EDS file.

Make sure that the .EDS file validation is successful.

If desired, select a new image file to represent the Gate-
way.

FIG. 38: Register the EDS File

FIG. 39: Browse to Graco Gateway EDS File

 

 

FIG. 40: EDS Validation

FIG. 41: EDS Image File
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Review the EDS registration, and finish the process. Select the DeviceNet Master by navigating in the tree on 
the left hand side. Navigate to: DeviceNet>Cate-
gory>Communication Adapter>1756-DNB/A. Select the 
appropriate Major Rev and drag it into the network work-
space at the right.

Select the Gateway Slave by navigating in the tree on 
the left. Navigate to: DeviceNet>Vendor>Graco Con-
trols>Generic Device. Select the Gateway-SERVER and 
drag it into the network workspace at the right.

Configure the master to add the slave device to the 
scanlist. Right click the DNB module and select proper-
ties.

From the Scanlist tab, select the Gateway-SERVER 
from the Available Devices pane, and add it to the Scan-
list pane. Select the Edit I/O Parameters button.FIG. 42: Review EDS Registration

  

FIG. 43: Configure the DeviceNet Master
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Make sure that the Strobed or Change of State boxes 
are not selected. In the Polled section, verify that the 
Input and Output sizes are 16 bytes. These must match 
the I/O Poll Size selections made above in the Gateway. 
In DeviceNet networks, 4 bytes constitute a full word. 
Therefore the 16 bytes selection represents 4 full words 
of addressable 32-bit data.

Select the Input tab. Verify that the four words of Gate-
way-SERVER data are mapped to YourDNB-
Slot:I.Data[0…3]. From the Output tab, verify that the 
four words are mapped to YourDNBSlot:O.Data[0…3].

Apply the changes, and save your RSNetWorx for Devi-
ceNet configuration.

FIG. 44: Apply and Save 
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Configure the Allen Bradley ControlLogix PLC
Allen Bradley ControlLogix PLCs are programmed with 
RSLogix 5000 programming software. To begin the 
DeviceNet configuration, launch RSLogix 5000 from 
your development PC.

Create a ControlLogix program containing a valid Devi-
ceNet Scanner. In this application a 1756-DNB was 
used.

FIG. 45: Create Valid DeviceNet Scanner
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Configure the DeviceNet Scanner to be address 0. 
Make sure to set up the 32-bit Input and Output memory 
spaces for a size of 32 (to match the configuration made 
above in both Gateway and RSNetWorx for DeviceNet).

Select the RSNetWorx tab, and navigate to the RSNet-
Worx for DeviceNet configuration that you have previ-
ously created. Open the configuration from here and 
download it to the network.

In the Main Task tree, open the Main Routine Ladder 
Logic file. Create a rung of ladder to enable the Devi-
ceNet network. The required output is always: 
Local:YourDNBSlot:0.CommandRegister.Run

Create a few rungs by taking the DeviceNet Input data, 
Local:2:I.Data[0…3], and adding 1 to them. Store the 
results in Local:2:O.Data[0…3]. Based on the configura-
tion in the Gateway, if values are changed on the Gate-
way Write tags, the Read tags will display the respective 
values, plus one.

Save and download this configuration to the Control-
Logix PLC.

Wire the DeviceNet Network
All DeviceNet networks require a termination resistor at 
the two end nodes on the network. Place a ¼ watt 120 
ohm resistor between CAN H (White) and CAN L (Blue) 
of the DeviceNet connection.

FIG. 46: Main Task Tree
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Appendix B: Profibus™ DP Slave Communication

Overview
This appendix describes the Gateway’s support for Pro-
fibus DP and details the configuration steps necessary 
to set up a Graco Gateway with an S7300 PLC, 
CPU315-2DP via Profibus. It does not provide a 
detailed description of Profibus, but only a brief introduc-
tion, necessary to define the terms that are used 
throughout the remainder of this document.

Introduction
Profibus DP stands for “Profibus for Decentralized 
Peripherals”. Profibus DP is a device level bus that sup-
ports both analog and discrete signals. It has wide-
spread usage for such items as remote I/O systems, 
motor control centers, and variable speed drives. Profi-
bus DP communicates at speeds from 9.6 Kbps to 12 
Mbps over distances from 100 to 1,200 meters.

The protocol supported by the Profibus DP option card 
is Profibus DP Slave. Therefore, the Graco Gateway 
must be linked to a Profibus network with a PLC.

Profibus Port Protocols
The Profibus option card has one Profibus port. See 
FIG. 47. 

Also see Appendix B: Profibus™ DP Slave Communi-
cation on page 57.

FIG. 47: Profibus PLC Connection
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About Profibus DP
Profibus DP communication takes the form of block 
exchange. Profibus blocks are made of memory bytes 
where 2 bytes make a word and 4 bytes a double word, 
or Dword.

A block is a range of consecutive byte addresses and is 
unidirectional. This means the PLC will exchange data 
read only and write only blocks with DP slave units. 
Addresses in each device are independent and only rel-
evant to the device for its own program. For example, 
the address range for the first block in the master can 
start at 256 with a 64 words block length and could 
result in the slave with a range starting from 0 with 64 
words length.

However, since blocks are consecutive, this means the 
first block start address, in the above example 256, will 
be the slave start address 0. Then, 257 in the master 
would be 1 in the slave, and so on.

Block length can be defined in bytes, words, or double 
words. Since start addresses between the master and 
the slave can be different, one could give its start 
address and length in bytes, and the other in words. 

For example, the master start address is byte 256, with 
a 64 words block length.

• This results in a range from byte 256 up to byte 383. 
The slave start address is word 0, with a 64 words 
block length.

• This results in a range from word 0 to word 63. FIG. 
48 illustrates this exchange.

NOTE: Do not forget that the Input block is independent 
from the Output block, and although the address range 
is the same, the data are different.

NOTE: FIG. 48 has no connection with the Input Block 
and Output Block in Graco Gateway. The terminology 
used in the tags configuration is from the PLC point of 
view (DP Master). Refer to Graco Gateway Setup for 
more information.

FIG. 48: Master/Slave Exchange

DP Master

Output Block
byte 256 to byte 383

Input Block
byte 256 to byte 383

DP Slave

Input Block
word 0 to word 63

Output Block
word 0 to word 63
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Setup the PLC
The Siemens Simatic Manager software is used to set 
up the S7300 PLC. The following figures and explana-
tions are extracted from this software.

Install the GSD file

The first step is to install the GSD file so Simatic is able 
to map data blocks to our device. Contact Graco Techni-
cal Assistance for Profibus GSD files.

Start Simatic Manager and open or create a new PLC 
project. Select the Simatic 300 Station in the navigation 
pane as shown in FIG. 49.

Double-click Hardware in the right hand window. This 
will start the HWConfig where most of the work is done. 
The HWConfig shows the current PLC hardware config-
uration. Close this configuration (NOT HWConfig) and 
choose Options>Install GSD File… FIG. 50.

FIG. 49: Select Simatic 300 Station

FIG. 50: Install the GSD File
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Click Browse to select the folder were the GSD file 
downloaded previously is, select the file and click Install. 
FIG. 51.

Once the GSD file is installed successfully, the PLC 
hardware setup can be opened again by doing Station 
and selecting the latest opened file which should be 
number 1.

If this is a new project, configure your PLC with the right 
modules.

FIG. 51: Browse to GSD File
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Setup the Profibus Network

The following steps show how to set up the Profibus DP 
network. Skip these steps if your PLC application 
already possesses a Profibus DP network.

In the floating window that represents the PLC, double 
click the DP area to open the properties window as 
shown in FIG. 52.

FIG. 52: DP Properties Window

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix B: Profibus™ DP Slave Communication 

62 312785C

In the General tab, click the properties button to open 
the Profibus properties. FIG. 53.

In the properties window, go to the Parameters tab and 
click on the New button to create a new network. FIG. 
54.

FIG. 53: Open Profibus Properties

FIG. 54: Create a New Profibus Network
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Select the Network Settings tab and choose the Trans-
mission Rate that fits the application. In this example, it 
will be 12 Mbps. The profile should be DP. FIG. 55.

Close the popup windows by clicking OK. HWConfig 
should now show the Profibus DP master system next to 
the PLC. FIG. 56.

FIG. 55: Set Transmission Rate

FIG. 56: Profibus DP Master System
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Add the Graco Gateway to the Profibus Network

To add the Graco Gateway to the Profibus network, drag 
the Gateway Profibus Card from the Catalog navigation 
situated on the right hand side of HWConfig to the Profi-
bus DP Master System. The card is situated under Profi-
bus DP>Additional Field Devices>MMI.

In the properties window that popped up, select the Pro-
fibus address the Gateway will take on the network. This 
address should be unique. In this example, the Gateway 
will take address 5. FIG. 57. Click OK.

FIG. 57: Add Graco Gateway to Profibus Network
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The Gateway is now on the Profibus DP network and 
selected. HWConfig shows the slots available under the 
Gateway to configure the data blocks to exchange.

Just drag and drop one of the data blocks available 
under the Gateway Profibus Card in the slot number 1. 
Simatic will automatically assign a start address (byte 
number) in the respective Input and output columns 
depending of the block type chosen. In this example, 64 
words in and 64 words out.

More blocks can be inserted in the following slots to fit 
your application. FIG. 58 shows an example with a 16 
words input block in slot 2 and 5 words output block in 
slot 3. Addresses are given automatically but can be 
edited by the user.

NOTE: If the starting address for a block in slot 2 or 
above changes and creates a gap in the address range, 
it will not affect the Gateway blocks, as all data are con-
secutive. It is however advised to keep the addresses 
consecutive to facilitate development.

Save the configuration and download it to the PLC.

NOTE:

• The maximum number of input bytes allowed is 
244.

• The maximum number of output bytes allowed 
is 244.

• The maximum number of bytes overall is 436.

FIG. 58: Configure Data Blocks
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Graco Gateway Setup
Once the PLC is setup, the Gateway can be pro-
grammed to fit its configuration.

NOTE: For a Gateway to communicate on Profibus DP, 
a Profibus Option card has to be fitted in the unit. Refer 
to the device manual to find the proper option card and 
installation procedure.

Setup the Profibus Communication

Enter the communication module and select the Gate-
way. On the right hand pane, click the Edit button to 
select the Option card. Select Profibus Option card and 
click OK. FIG. 59.

FIG. 59: Select Profibus Option Card
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The option card appeared in the communication tree. 
Select the Profibus Interface and click the Edit button to 
select a driver. Click OK to pick the Profibus DP driver. 
FIG. 60.

Graco Gateway now displays the driver settings where 
the Station Address can be changed. This address is 
the Gateway address on the Profibus network. In our 
example, this address is 5 as setup in the PLC earlier.

NOTE: There are no Baud Rate settings as the Profibus 
option card detects the transmission rate automatically.

A device called PLC1 is now displayed under the Profi-
bus Interface. This device represents the Profibus Mas-
ter and can be renamed to fit the application. In this 
example, the name PLC1 remains. FIG. 61.

FIG. 60: Select Profibus Server

FIG. 61: Block Settings
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Setup Tags

Once the communication is set up, tags can be created 
to access the PLC blocks. This is where the  section 
Setup the Profibus Communication, page 66, is 
important.

First, create a variable that correspond to the data type 
required. In this example, an integer. FIG. 62.

Select the variable and rename it eventually. Then, click 
on Internal next to mapping on the right hand side pane, 
and select PLC1, which is the Profibus Master. FIG. 63.

FIG. 62: Create a Variable

FIG. 63: Variable Properties

Select PLC1 from 
pulldown menu
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In the popup window, select the block type required. Two 
choices are available:

• Input block: The terminology input is from the Sie-
mens perspective. Therefore this will be a block the 
Gateway will write to. The tag mapped to an input 
block has to be set up as Write Only.

• Output block: The terminology output is from the 
Siemens perspective. Therefore this will be a block 
the Gateway will read from. The tag mapped to an 
output block has to be set up as Read Only.

• Select the data offset, which points the address to 
read or write in the block. Select the data type to 
read or write. This defines how many bytes to 
access in the block to get the correct data. In this 
example we choose output block, with data offset 0 
(Which points to 256 in the PLC) and as a Word. 
FIG. 64.

NOTE: Since the output block is a reading block from 
the Gateway standpoint, this variable should be set up 
as Read Only as shown in Fig. 19. The same rule 
applies if the block is an input block, it should be set up 
as Write Only.

To avoid mistakes, the mapping shows with an R or W 
for output or input block respectively. FIG. 65.

FIG. 64: Select Block Type

FIG. 65: Properties of Variable
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How Addressing Works

PLC addressing is in byte and uses the scheme shown 
in FIG. 66.

The Gateway addressing follows a different scheme, as 
shown in FIG. 67.

This means that the address number will be different 
when accessing words or Dwords in the Gateway data 
tags than the PLC. Table 6 shows the address relation-
ship for integer tags mapped as word in the Gateway.

FIG. 66. PLC Addressing Scheme

Byte 0

Byte 1

Byte 2

Byte 3

Byte 4

Byte 5

Byte 6

Byte 7

Byte 8

Byte 9

Word 0

Word 2

Word 4

Word 6

Word 8

Dword 0

Dword 4

Note how a Dword or word address starts at the 
address of the first byte included in it.

FIG. 67. Gateway Addressing Scheme

Byte 0

Byte 1

Byte 2

Byte 3

Byte 4

Byte 5

Byte 6

Byte 7

Byte 8

Byte 9

Word 0

Word 1

Word 2

Word 3

Word 4

Dword 0

Dword 1

Here, the word or Dword addresses follow the nor-
mal numeric increment and are not directly related 
to the word or bytes they are composed of.

Table 6: Addressing Relationship

Block Type

PLC Gateway

Input (bytes) Output (bytes) Input (words) Output (words)

64 words in, 64 words out 256...383 256...383 0...63 0...63

16 words in 384...415 - 64...79 -

5 words out - 384...393 - 64...68
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Useful Formulas

The following formula can be used to find the byte num-
ber from a word address:

ByteAddress = PLCOffset + (WordAddress x 2), where:

• ByteAddress is the address we are looking for in the 
PLC

• PLCOffset is the first byte number in the complete 
block mapping in the PLC, here 256

• WordAddress is the address mapped in the Gate-
way. So, for example, word 77 in the Gateway, 
would start at byte 410 in the PLC, and so would be 
composed of byte 410 and 411.

The following formula can be used to find the byte num-
ber from a Dword address:

ByteAddress = PLCOffset + (DWordAddress x 4), 
where:

• ByteAddress is the address we are looking for in the 
PLC

• PLCOffset is the first byte number in the complete 
block mapping in the PLC, here 256

• DwordAddress is the address mapped in the Gate-
way. So, for example, Dword 14 in the Gateway, 
would start at byte 312 in the PLC, and so would be 
composed of byte 312, 313, 314 and 315.

NOTE: For the formula to work, all the blocks in the PLC 
Profibus configuration for the Gateway have to be con-
secutive. FIG. 57.
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Appendix C: Graco Gateway to ControlLogix via 
Ethernet IP

Overview
This appendix describes the configuration steps neces-
sary to establish a communication path between the 
Graco Gateway and a ControlLogix unit. You will need 
either a 1756-ENET/B or a 1756-ENBT/A together with 
a Logix5550 controller. It may be possible to upgrade a 
1756-ENET/A to the required 1756-ENET/B by flashing 
the firmware; you should check the hardware version 
with your vendor before hand to ensure its suitability. 
You will also need Rockwell Software’s RSLinx and 
RSLogix 5000 software configuration utilities.

Introduction 
In the following example, the ControlLogix will establish 
a Class1 connection and I/O data will be exchanged 
between the ControlLogix and the Graco Gateway termi-
nal. The network parameters used in this example will 
almost certainly not apply to your application. Be sure to 
consult your network administrator when selecting 
appropriate values.

FIG. 68: Ethernet PLC Connection

TI15057a

Ethernet Connection 
to PLC
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ControlLogix Configuration 
1. Run the RSLogix 5000 program and create a new 

configuration.

2. Add a 1756-ENET/B or a 1756-ENBT/A to your I/O 
configuration. You will need to:

a. Switch to offline mode.

b. Right click on the I/O Configuration node in the 
Controller Organizer view and choose Add Mod-
ule.

c. In the Select Module Type window, choose 
1756-ENET/B or 1756-ENBT/A entry. RSLogix 
will open the Module Properties window. See 
FIG. 69.

d. Enter the IP Address of the ENET/B or ENBT/A 
interface.

e. Click Finish to add the interface to your I/O con-
figuration.

f. Download the configuration.

g. Switch to online mode and open the 
1756-ENET/B or 1756-ENBT/A node proper-
ties under the I/O Configuration in the Controller 
Organizer.

h. Select the Port Configuration Tab from the Mod-
ule Properties window. See FIG. 70.

i. Enter the IP Address and Subnet Mask. The IP 
Address must match the IP Address entered in 
the Properties window (FIG. 69).

j. Apply the settings using the Set button. 

k. You can now verify the network module network 
communications with your unit using suitable 
diagnostic tools such as Ping.

3. Add the Graco Gateway to the RSLogix configura-
tion as follows:

a. Switch to offline mode.

b. Right click on the 1756-ENET/B or 
1756-ENBT/A node under the I/O Configuration 
in the Controller Organizer view and choose 
Add Module.

c. In the Select Module Type window, choose 
Generic Ethernet Module. See FIG. 71.

d. Click OK. This will open the Module Properties 
window. See FIG. 72.

FIG. 69. Ethernet Module Properties

IP Address

Finish Button
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FIG. 70. Port Configuration Window

IP Address

Subnet Mask

Set Button

FIG. 71. Ethernet Module Selection
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e. In the Name field, enter a descriptive name to 
identify the module. See FIG. 72.

f. In the Address/Host Name field, enter the IP 
Address of the Graco Gateway.

g. Enter 2 in the Input Assembly Connection Point 
and a size of 2. This will match a read only 
Slave Gateway block configured in the Gateway, 
and will be used for reading data from the Gate-
way to the ControlLogix.

h. Enter 3 in the Output Assembly Connection 
Point and a size of 2. This will match a 
read/write Slave Gateway block configured in 
the Gateway, and will be used for writing data 
from the ControlLogix to the Gateway.

i. Enter 1 in the Configuration Connection Point 
and a size of 0. Configuration data is not sup-
ported by the Gateway.

j. Press Finish to add the Gateway to the I/O con-
figuration. 

The connection points and sizes are arbitrary, as 
long as the connection point, size, and direction are 
matched in the configuration of the Gateway.

Connection point direction is always relative to the 
originator, which in the case of the current Gateway 
Ethernet/IP implementation is always the device and 
never the Gateway. An input connection therefore 
specifies data flow from the Gateway to the device, 
and an output connection specifies data flow from 
the device to the Gateway.

FIG. 72. Ethernet Module Properties
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See FIG. 73. You should now see a new ETHER-
NET-MODULE Gateway_HMI branch of the 
1756-ENET/B node in the I/O Configuration view. 
You should also see three new entries in the Con-
troller Tags view:

• Gateway_HMI:I to view the input data
• Gateway_HMI:O to modify the output data
• Gateway_HMI:C to view the configuration data

4. Download the new I/O configuration to the control-
ler. Once the download is complete, the controller 
will automatically establish a new Class1 connection 
with the Gateway.

FIG. 73. Ethernet Configuration Data
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Graco Gateway Configuration 
1. Ethernet Settings. Set the IP Address to 

192.168.2.101. This should match the Address/Host 
Name entered in FIG. 72.

2. Protocol Settings. Select the Ethernet/IP Slave 
Adapter communications driver.

The ENET/B module prefixes all output data with a 
header containing status information about the orig-
inator’s run/idle state. With the Run/Idle Header 
checked, the communications driver will automati-
cally process the header, and data will be ignored if 
the device is in the Idle state. With the option 
unchecked, extra space must be allocated in the 
Gateway block to receive the status information; all 
data is accepted regardless of the device state.

3. Device Settings. A Gateway block must be created 
for each connection point.

For the purpose of configuring, the data transfer 
terms input and output are relative to the device and 
not the Gateway. An input connection is therefore 
specified as Gateway to Device, and an output con-
nection is specified as Device to Gateway.

Connection point mapping is defined in the Start 
Address block setting and comprises the connection 
point instance and a data offset. The instance must 
match that specified by the originator; the offset can 
be used to skip over data not required by the Gate-
way, useful mainly on shared connection points.

FIG. 74. Ethernet Block Settings
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The following settings mirror the I/O settings of the 
ControlLogix configuration detailed earlier.

a. Input Connection Point. Create a Gateway 
block configuration (see Table 7).

b. Output Connection Point. Create a Gateway 
block configuration (see Table 8).

4. Data Mapping. the connection points are now con-
figured so that:
Gateway_HMI:O >> PLC1:Block1
Gateway_HMI:I << PLC1:Block2 

5. Testing. Using the RSLogix5000 program, you can 
modify tags Gateway_HMI:O and verify they are 
written into Var1 and Var2, and verify changes made 
in the Gateway to tags Var3 and Var4 are updated in 
Gateway_HMI:I. Ensure the device is in the Run 
mode, otherwise the data transfer will be ignored by 
the Gateway.

Table 7: Input Connection Points

Connection Point 2

Data Offset 0000

Data Type Long as Long

Block Size 2

Direction Graco Gateway to Device

Table 8: Output Connection Points

Connection Point 3

Data Offset 0000

Data Type Long as Long

Block Size 2

Direction Device to Graco Gateway
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Dimensions

TI12825b

16.57 in. (420.9 mm)

15.07 in. (382.8 mm)

4.52 in. 
(114.8 mm)

5.31in. 
(134.9 mm)

8.71in. 
(221.2 mm)

TI12930a
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Technical Data

Electrical power  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24 Vdc, +/- 10%. 200 mA minimum without expansion card; 1 
Amp maximum with expansion card fitted. Requires Class 2 or 
SELV rated power supply.

Communication ports
USB/PG Ports  . . . . . . . . . . . . . . . . . . . . . . . . . .

Serial Ports  . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RS232/PG Port  . . . . . . . . . . . . . . . . . . . . . . . . .
COMM Ports  . . . . . . . . . . . . . . . . . . . . . . . . . . .
DH485 TXEN Port . . . . . . . . . . . . . . . . . . . . . . .

Ethernet Port . . . . . . . . . . . . . . . . . . . . . . . . . . .

Adheres to USB specification 1.1. Device only using Type B 
connection.
Format and Baud rates for each port are individually software 
programmable up to 115,200 baud.
RS232 port via RJ12.
RS422/485 port via RJ45, and RS232 port via RJ12.
Transmit enable; open collector, VOH=15 Vdc, VOL=0.5 V @ 25 
mA maximum.
10 BASE-T/100 BASE-TX, RJ45 jack is wired as a NIC (Net-
work Interface Card).

LEDs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . STS: Status LED indicates condition of Gateway module.
TX/RX: Transmit/Receive LEDs show serial activity.
Ethernet: Link and activity LEDs.
CF: CompactFlash LED indicates card status and read/write 
activity.

Memory
On-board user memory . . . . . . . . . . . . . . . . . . .
On-board SDRAM . . . . . . . . . . . . . . . . . . . . . . .
Memory card . . . . . . . . . . . . . . . . . . . . . . . . . . .

4 Mbytes of non-volatile Flash memory.
2 Mbytes
CompactFlash Type II slot for Type I and Type II cards. Used for 
optional database storage only.

Real-time clock . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Typical accuracy is less than 1 minute per month drift. Lithium 
coin cell battery; typical lifetime of 10 years at 25°C. This unit is 
not field serviceable. All work must be done by a qualified tech-
nician.

Environmental conditions
Operating temperature range. . . . . . . . . . . . . . .
Storage temperature range . . . . . . . . . . . . . . . .
Operating and storage humidity. . . . . . . . . . . . .
Vibration according to IEC 68-2-6 . . . . . . . . . . .
Shock according to IEC 68-2-27  . . . . . . . . . . . .
Altitude . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

0 to 50°C
-30 to +70°C
80% relative humidity, non-condensing, from 0 to 50°C
Operational 5 to 150 Hz, in X, Y, Z direction for 1.5 hr, 2 g’s
Operational 30 g, 11 msec in 3 directions
Up to 2000 m

Construction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Carbon steel and stainless steel. Installation category 1, Pollu-
tion degree 2.

Power connection . . . . . . . . . . . . . . . . . . . . . . . . . . . Removable wire clamp screw terminal block. Wire gage capac-
ity: 24 AWG to 12 AWG. Torque: 4.45-5.34 in-lb (0.5-0.6 N•m).

Mounting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Snaps onto standard DIN style top hat (T) profile mounting rails 
according to EN50022 -35 x 7.5 and -35 x 1.5.

Weight (Gateway control box only) . . . . . . . . . . . . . . 15.1 oz (456.4 g)
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Graco Standard Warranty
Graco warrants all equipment referenced in this document which is manufactured by Graco and bearing its name to be free from defects in 
material and workmanship on the date of sale to the original purchaser for use. With the exception of any special, extended, or limited warranty 
published by Graco, Graco will, for a period of twelve months from the date of sale, repair or replace any part of the equipment determined by 
Graco to be defective. This warranty applies only when the equipment is installed, operated and maintained in accordance with Graco’s written 
recommendations.

This warranty does not cover, and Graco shall not be liable for general wear and tear, or any malfunction, damage or wear caused by faulty 
installation, misapplication, abrasion, corrosion, inadequate or improper maintenance, negligence, accident, tampering, or substitution of 
non-Graco component parts. Nor shall Graco be liable for malfunction, damage or wear caused by the incompatibility of Graco equipment with 
structures, accessories, equipment or materials not supplied by Graco, or the improper design, manufacture, installation, operation or 
maintenance of structures, accessories, equipment or materials not supplied by Graco.

This warranty is conditioned upon the prepaid return of the equipment claimed to be defective to an authorized Graco distributor for verification of 
the claimed defect. If the claimed defect is verified, Graco will repair or replace free of charge any defective parts. The equipment will be returned 
to the original purchaser transportation prepaid. If inspection of the equipment does not disclose any defect in material or workmanship, repairs will 
be made at a reasonable charge, which charges may include the costs of parts, labor, and transportation.

THIS WARRANTY IS EXCLUSIVE, AND IS IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED 
TO WARRANTY OF MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE. 

Graco’s sole obligation and buyer’s sole remedy for any breach of warranty shall be as set forth above. The buyer agrees that no other remedy 
(including, but not limited to, incidental or consequential damages for lost profits, lost sales, injury to person or property, or any other incidental or 
consequential loss) shall be available. Any action for breach of warranty must be brought within two (2) years of the date of sale.

GRACO MAKES NO WARRANTY, AND DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, IN CONNECTION WITH ACCESSORIES, EQUIPMENT, MATERIALS OR COMPONENTS SOLD BUT NOT 
MANUFACTURED BY GRACO. These items sold, but not manufactured by Graco (such as electric motors, switches, hose, etc.), are subject to 
the warranty, if any, of their manufacturer. Graco will provide purchaser with reasonable assistance in making any claim for breach of these 
warranties.

In no event will Graco be liable for indirect, incidental, special or consequential damages resulting from Graco supplying equipment hereunder, or 
the furnishing, performance, or use of any products or other goods sold hereto, whether due to a breach of contract, breach of warranty, the 
negligence of Graco, or otherwise.

FOR GRACO CANADA CUSTOMERS
The Parties acknowledge that they have required that the present document, as well as all documents, notices and legal proceedings entered into, 
given or instituted pursuant hereto or relating directly or indirectly hereto, be drawn up in English. Les parties reconnaissent avoir convenu que la 
rédaction du présente document sera en Anglais, ainsi que tous documents, avis et procédures judiciaires exécutés, donnés ou intentés, à la suite 
de ou en rapport, directement ou indirectement, avec les procédures concernées.

Graco Information 
For the latest information about Graco products, visit www.graco.com.

TO PLACE AN ORDER, contact your Graco distributor or call to identify the nearest distributor.
Phone: 612-623-6921 or Toll Free: 1-800-328-0211 Fax: 612-378-3505
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